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Disclaimer

The information in this manual is furnished for informational use only and subject to
change without notice. While every effort has beenmade to ensure that the information
contained in this user manual is accurate, up-to-date and reliable, EVS Broadcast
Equipment cannot be held responsible for inaccuracies or errors that may appear in this
publication.

Improvement Requests

Your comments will help us improve the quality of the user documentation. Do not
hesitate to send improvement requests, or report any error or inaccuracy on this user
manual by e-mail to doc@evs.com.

Regional Contacts

The address and phone number of the EVS headquarters are usually mentioned in the
Help > About menu in the user interface.

You will find the full list of addresses and phone numbers of local offices either at the end
of this user manual (for manuals on hardware products) or at the following page on the
EVS website: http://www.evs.com/contacts.

User Manuals on EVS Website

The latest version of the user manual, if any, and other user manuals on EVS products
can be found on the EVS download center, on the following webpage:
http://www.evs.com/downloadcenter.
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What's New?

In the user manual, the icon has been added on the left margin to highlight
information on new and updated features.

The sections updated to reflect the new andmodified features in plugin 1.3 (compared to
version 1.2) are listed below.

Use of licenses

Themanagement of licenses has changed: the use of plugin requires a DB Connect
license and an IP Access license.

• See section "Licenses" on page 3.
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1. Introduction

1.1. Product Description
IPLink for Adobe is a plugin panel extension for use with Adobe Premiere Pro CC.

It can be used in those situations where it is desirable to be able to access clip elements
that aremade available for editing by IPDirector whilst the live event is taking place. In
this case, access to the underlyingmedia files aremade using shared storage that is
managed by IPDirector.

The IPLink for Adobe plugin panel allows the users to be able to search for clip elements
based upon the IPDirector held metadata (Clips, Bins, Logs) and be able to preview and
use the associated files stored on the shared storage. In this way the users do not have to
navigate and import clip elements directly from the shared storage and allow direct access
to the files from Premiere Pro CC without having tomove or copy files to the local
workstation storage.

A main advantage for many live events is that themetadata associated with the event
may be continuously updated by users of the EVS production system. With IPLink for
Adobe, visibility of new or updatedmetadata is possible from within the panel in Premiere
Pro CC thereby allowing editorial decisions to bemade in a timely manner.

1.2. Media Workflow

Content originating from cameras or other sources is recorded to EVS servers and
managed using IPDirector applications.

Using IPDirector the operator can create clips and initiate jobs to allow the content on the
server to bemade available onto nearline storage that is also beingmanaged by
IPDirector. EVS XSquare/XTAccess is used to stream the clip media to the nearline
storage in a format that is compatible with Premiere Pro CC.

The operator can also apply additional metadata and logs to one or several clips.
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Within Premiere Pro CC, editors can use the IPLink plugin panel to connect to the EVS
production system and search for clips based upon themetadata held in the IPDirector
database. The connection between the IPLink panel and IPDirector is made via the
IPDirector API. The editor is also able to list the logs that are held in the EVS production
system.

The editor can load themedia associated with clips or logs directly into the source video
monitor of Premiere Pro CC and review and play the video content.

The video content can be used in the Premiere Pro CC project by simply marking in-out
points on the loaded clip and editing directly to the sequence timeline. This will import the
clip into the Premiere Pro CC project.

The video files representing the clips are accessed directly on the nearline storage by
Premiere Pro CC over the network.

Once the edit is completed, the sequence is exported from Premiere Pro CC using the
normal export tools within the editing application back onto specified locations on the
nearline storage.

The folder locations on nearline storage aremonitored by XSquare/XTAccess and when
the exportedmedia file is discovered, an appropriate job is started tomake themedia
available to be played out on the EVS server. Alternatively depending upon the XSquare
job profile associated with the nearline folder location, other actions may be executed.

1.3. Main Features
• Adobe Premiere Pro CC plugin extension panel.

• Microsoft Windows & AppleMac OS support.

• Clips, bins & logsheets accessible.

• User visibility of clips, bins & logs dependent on user IPDirector login user rights.

• Customizable metadata views.

• Full text search with autocomplete function.

• Advanced search criteria.

• User selectable auto-refresh.
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• Load clips directly into Adobe Premiere Pro CC source videomonitor.

• Based on logs, clips are parked at the respective timecode position.

• Media files accessed directly from EVS IPDirector managed nearline storage, no
transfer of media files to Adobe workstation needed.

1.4. System Requirements
IPLink for Adobe can be installed onto a workstation that is running Adobe Premiere Pro
CC.

For further information on operating system support and workstation hardware
requirements to run Adobe Premiere Pro CC refer to the Adobe website
(http://www.adobe.com/products/premiere.html).

For the application requirements and changes, refer to the IPLink for Adobe Release
Notes.

1.5. Licenses
IPLink for Adobe works with floating licenses imported to XSecure in the database.

Some users, like editors, need a guaranteed connection to IPLink for Adobe. So, a static
license will be installed on their workstation.

For users who do not need to have a guaranteed connection, such as journalists, no static
license will be installed and a pool of floating licenses can be used on a first come/first
served basis. So a larger number of stations can be equipped with IPLink for Adobe.

Actually, when IPLink for Adobe is started, the system first checks whether a license for
DBConnect exists on the workstation. This license is always a floating license (key 05). It
controls the number of workstations which connect to the database. If there is no valid
license, the user gets an error message. If a valid DBConnect license exists, it is used.

The system then requests a floating IPAccess license (key 115). If such a license is
available, it is used for that user. If there is no floating license left at that time, the user
gets an error message.
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2. Installation

2.1. Prerequisite
In order to install the IPLink for Adobe plugin, the following software should already be
installed on the Adobe Premiere Pro CC workstation:

• Adobe Premiere Pro CC

• Adobe ExtensionManager CC

• Java 7

• QuickTime (if using Adobe Premiere Pro CC onMSWindows operating system)

Note
This software is not provided by EVS.

For version information refer to the IPLink for Adobe release notes.

2.2. Installation on Mac OS Computer
To install the IPLink for Adobe plugin on your Mac OS computer, proceed as follows:

1. Copy the IPLinkSetup.dmg installation file locally.

2. Double-click the installation file or icon to launch the installation wizard.

3. Double-click the Install IPLink icon from the following window:

4 2. Installation
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4. Click Continue from the Installer window to launch the installation process:

The IPLink plugin is being installed.

Youmay be asked a number of times to enter the administrator password in order for
the installer to make changes to the workstation as part of the install process. Please
see your system administrator to obtain the required password.

5. Click OK when the installation is complete.
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2.3. Installation on Windows OS Computer
To install the IPLink for Adobe Plugin on yourWindows computer, proceed as follows:

1. Copy the IPLinkSetup.exe installation file locally.

2. Double-click the installation file or icon to launch the installation wizard:

3. From the Security Warning window, click Run in order to run the installation
executable:

4. From theWelcomewindow, click Next to access the installation parameters:

6 2. Installation
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5. From the Choose Components window, click Install to launch the installation of the
plugin:

The installation of the plugin is launched, it may take several minutes:

6. Click Closewhen the installation is complete.
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3. Getting Started

3.1. Opening the IPLink for Adobe Plugin
To open the IPLink for Adobe plugin from the Premiere Pro CC, select Extensions >
IPLink from theWindow menu:

3.2. Configuring IPLink

3.2.1. Accessing the Settings Window
To access the Settings window from the IPLink for Adobe plugin , click thePreferences

button at the top right of the IPLink panel.

The Preferences window contains 4 tabs.

Note
If this is the first time the application is launched after installation you should
configure the settings prior to using it.

3.2.2. General
TheGeneral tab is used to configure general parameters such as:

• Sequence template for edit imports.

• Request timeout: sets the timeout for requests to the IPDirector API.

• Auto-update: enables auto-refresh of the IPLink Elements grid.

• Maximum Number of Audio Tracks: The number of audio tracks that will be
represented as part of the clip metatdata when clip assets are imported using the
IPLink plugin.
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• Enable ES Marker: Used in specific versions of Premiere Pro CC when importing logs
into the Premiere Pro CC project. (See IPLink for Adobe release notes for details)

Note
The possible metadata columns can be selected usingOrganize Columns.

For convenience, theGather Logs button in the Preferences window can be used to
export the IPLink log files to a user specified location.

3.2.3. Searches
The Searches tab is used to specify setting related to search behavior.

• Maximum Results Clips: sets the number of search results that will be shown in
IPLink plugin when Clip searches aremade.

• Maximum Results Edits: Sets the number of search results that will be shown in
IPLink plugin when Edit searches aremade.

• Maximum Results Logs: Sets the number of search results that will be shown in
IPLink plugin when Logs searches aremade.
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• Default Search: When the Library node in the Tree view is selected, the default results
that will be displayed will be that of the specified type (Bins, Edits or Logs).

• Search Scope: When searches are performed, the search will be against All
Columns or only against Visible Columns for that item type.

3.2.4. Path Mappings
The Pathmappings tab is used tomap the IPDirector nearline paths ontoMac local paths
when IPLink is used on aMac OS workstation.

By default, if no entry is entered for Server Path or Local Path, then IPLink will try and
perform an intelligent translation of IPDirector paths against theMac OS file system
mounts for the IPDirector nearline file system. If however IPLink is unable tomake the
appropriate translation then it will be necessary to enter values into the PathMappings
table.

In the PathMappings table, enter the information required to translate the IPDirector
nearline path to theMac volume path where themedia is read from. Add any additional
pathmappings for other items such as the Thumbnails share location.

Note
TheMac volumemust have been previously mounted on the workstation using
theMac ‘Finder’.

• The Server Path is the path defined to the nearline as configured in IPDirector. It must
be entered exactly as it is defined in IPDirector and it is case sensitive.

• The Local Path is the path by which theMac will play themedia files from the
IPDirector nearline, and needs to be described as aMac path. It is also case
sensitive.
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Tip
• The Server Path can be copied directly from the IPDirector Nearline

Management tab in the Remote Installer as illustrated:

• The Local Path can be found by connecting to the nearline from theMac
(using Finder, Go > Connect to Server), then selecting a clip within the
nearline. Hold theCTRL key and click on the clip, then select Get Info (or
useCMD+I keyboard shortcut). The exact path will be shown in the General
Info section under the title 'Where'.

3.2.5. Connection
The Connection tab is used to configure the connection to an IPDirectorWS API
instance. Youmust have an IPDirectorWS API running in order for IPLink to properly
connect and operate.

1. Enter the Server IP address or host namewhere the IPDirector API instance is
running.

Note
A DNS is needed should the host name need to be resolved to a network IP
address.

USER MANUAL IPLink for Adobe 1.3 Plugin

3. Getting Started 11



2. Enter theWeb Services Server Port to connect to.

Note
By default this is 31016, and should only be changed after consultation of EVS
Support staff.

3. Enter the login and password of the user with which to connect. This should be an
IPDirector user created from within the IPDirector User Manager.

4. Select the version of IPDirector that is being connected to.

5. Click Save to confirm the selection.

You will need to close the IPLink window and open it again from Premiere Pro CC
(Window>Extensions>IPLink) for the settings to be used.

For details of the versions of IPDirector supported by IPLink, refer to the IPLink for Adobe
Release Notes.
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4. User Interface

4.1. Overview of the IPLink Window

Illustration

The IPLink for Adobe window contains the areas highlighted on the screenshot below:

Area Description

The table below describes the various parts of the IPLink for Adobe window:

Area Description

1. Tree View The Tree view displays the clips, bins, edits and logs present in the
EVS Production system and based on the EVS user rights. The tree
branches can be used to filter the items displayed in the Elements
grid.
See section "Tree View" on page 15 for details on the interface.

2. Breadcrumb This area shows the location selected in the Tree view. It can be
used to navigate through and get to the parent folder from the current
position in the tree.

USER MANUAL IPLink for Adobe 1.3 Plugin

4. User Interface 13



Area Description

3. Quick Text
Search area

TheQuick Text Search area provides the ability to perform quick
free text searches.
See section "Quick Text Search Area" on page 22.

4. Toolbar
buttons

Refresh button: used to refresh the contents of the Elements grid
There is a similarRefresh button on the Tree View panel that can be
used to update the Tree View area.
Preferences button: used for IPLink configuration. See section
"Configuring IPLink" on page 8.
Organize Columns button: used for the display of columns in the
Elements grid.

5. Display
Filter
buttons

This area provides buttons to filter the content of bins based on the
type of the item: clips or edits.

6. Elements
grid

The Elements grid displays all the items included in the selected
tree branch, or breadcrumb, or resulting from a search.
The total number of results found is shown in the bottom bar.
See section "Elements Grid" on page 18.

7. Advanced
Search pane

The Advanced Search area allows augmentation of search filters
and the available options depends on the item context being
searched for such as clips, edits or logs metadata.
See section "Advanced Search Pane" on page 22.

8. Application
Version
number

This area displays the version number of the IPLink for Adobe
plugin.

9. Import
button

This button is used to start the import of the item(s) selected from
the Elements grid into a Premiere Pro CC project.
See section "ImportingMedia into Premiere Pro" on page 31.

10. Camera
Angles
buttons

These buttons are used to select and preview the individual angles
before using them in an edit or importing them to the Premiere Pro
project. See section "ImportingMedia into a Project" on page 31

Adaptable Display

The layout of the IPLink for Adobe can be adapted to users' needs:

• The Tree View and the Advanced Search pane can be hidden by clicking the arrow

icon or un-hiden by clicking .

• The Tree View and the Advanced Search pane can be enlarged or reduced by clicking
(and holding) the split box control andmoving it to the left or to the right:
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4.2. Tree View

4.2.1. Introduction
The Tree view allows the users to navigate and browse the items made available for use,
thesemay be all the clips made available on the IPDirector managed nearline, edits and
logsheets or clips and edits stored in bins.

Click the arrow next to a tree branch to expand a branch. By browsing the tree structure, a
selection is made and the items available displayed in the Elements grid. See section
"Branch Selection in the Tree" on page 24.

The associatedRefresh button is used to refresh the Tree view content.

4.2.2. Tree View Elements
The current sectionmentions which items are displayed in the Elements grid based on the
tree branch selected.

Storage

Selecting this branch displays, in the Elements grid, all the clips present in all the
available IPDirector managed nearline storages.

Bins

Selecting this branch displays, in the Elements grid, all the clips or edits which are in bins
and bin directories.

The type of items (clips or edits) to display in the Elements grid is selected by clicking a
Display Filter button.
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Expanding the Bins view shows the bins and bin directories in the Tree view, as detailed
in the table below:

Tree Branch /
Sub-Branch Description

Bin Directory: shows all the elements which are in all the bins and
directories under the selected directory.

Bin: shows all the elements which are in the selected bin.

Users Bin Directory: shows all the elements which are under all
the System [User] bin directories that are created using the EVS
Production system.
This directory cannot bemodified through the IPLink panel.
Expanding the Users Bin Directory view displays the System [User]
bin directories for all the users:

System [User] Bin Directory: shows all the elements which are in
the bins and bin directories for the selected user.
Expanding a System [User] Bin Directory view displays all the bins
and bin directories for the selected user (here: pge). Its name
contains the user logging ID.

This directory and its bins cannot bemodified through the IPLink
panel. Only users of the EVS Production system tools and
applications canmodify the contents of these bins.

System [User] Bin created by the EVS Production system for the
selected user. Its name contains the user logging ID.
It shows all the elements put in it by the selected user.
It is visible by all the users but it contents cannot bemodified
through the IPLink panel.

[User] Bin: created by the selected user under its System [User]
bin directory.
It shows all the elements put in it by the selected user.

[User] Bin Directory: created by the selected user under its
System [User] bin directory.
It shows all the elements put in it by the selected user.
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Edits

Selecting this branch displays, in the Elements grid, all the edits present in the IPDirector
database.

Edits may have been created from the IPD Xedio Plugin, the Director's Cut module of
IPDirector or the IPBrowse application. They can also be created by the IPMosGateway
NRCS systems as Autocreate placeholders.

Note
Limitation: Currently it is not possible to import edits containing clip elements
into Premiere Pro CC using the IPLink panel. Only placeholder empty edits can
be imported. This allows import of placeholder edits where specific EVS
metadata needs to be associated with the sequence (e.g. custommetadata
fields) once it has been imported into Premiere Pro CC. In order to import other
types of edits, including those that reference clip elements, export the edit
metadata from IPDirector as a FCP 7.x EDL XML to a file share andmanually
import into Premiere Pro CC.

Logsheets

Selecting this branch displays, in the Elements grid, all the logs present in the IPDirector
database.

Expanding the Logsheets view shows the log sheets and log directories in the Tree view,
as detailed in the table below:

Tree Branch /
Sub-Branch Description

Log Directory: shows all the logs from all the log sheets which are
in the selected directory.

Log Sheet: shows all the logs which are in the selected log sheet.

Log sheet of which all the logs are protected.

Log sheet of which some of the logs are protected.

Log sheet of which none of the logs is protected.
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4.2.3. Keyboard Shortcuts
The following shortcuts can be used in the Tree view:

Key Action / Behavior

Up Arrow Select the previous line

Down Arrow Select the next line

Left arrow Collapses the branch

Right Arrow Expands the branch

4.3. Elements Grid

4.3.1. Introduction
The Elements grid represents the content of the tree branch selected in the Tree view, or
the content corresponding to the displayed breadcrumb. It can also returns the result of a
search applied with a filtering tool to the elements of a selected branch of the Tree view.

Bins can contain clips or edits. WhenBins is selected from the Tree view, the item type

to display will be selected by clicking the correspondingDisplay Filter button: for

clips, for edits.

In the grid, elements are presented in rows and all their associated parameters and
metadata are in columns.

The total number of results found is shown at the bottom right of the Elements grid. The
number of results that are displayed can be adjusted through thePreferences option.

4.3.2. Sorting the Elements in the Grid
At start of the application, items are sorted with most recent on top.

You can change the sort order of elements in the grid by clicking the column header for the
parameter according to which you want to sort the elements.

The little triangle indicates the sorting order. Clicking the column header again changes
the sorting order from ascending to descending or vice versa.

4.3.3. Organizing Columns
Columns can be resized and/or re-ordered. This new organization is automatically saved
and remembered. However, it is also possible to reset the column organization to the
default organization.
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Resizing Columns
A column can be resized by using themouse pointer over columns intersection and
dragging it to the right or to the left.

Selecting Columns to Display
To select the columns to display in the grid, proceed as follows:

1. Click theOrganize Columns button at the top right of the IPLink plugin window.

The Select Columns window opens and the right pane shows the list of columns in the
current order.

2. To select the column(s) you wish to add to the view, select them in the left pane and
click the right arrow

3. To select the column(s) you wish to remove from the view, select them on the right
pane and click the left arrow

4. Click Save.

Ordering Columns
To change the columns order, proceedas follows:

1. Click theOrganize Columns button at the top right of the IPLink plugin window.

The Select Columns window opens and the right pane shows the list of columns in the
current order.

2. Select the column name from the Selected Columns pane.

3. Click the appropriate button:

◦ : moves the item before the previous one

◦ : moves the item after the next one

4. Click Save.
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Resetting the Column Organization to the Default One
Users can reset the column organization to the default one (columns selection, order,
size,...).

To do so, proceed as follows:

1. Click theOrganize Columns button at the top right of the IPLink plugin window.

2. Select the tab corresponding to the type of item for which you want to reset the grid.

3. Click Reset.

4. Click Save.
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4.3.4. Operations Allowed from the Elements Grid
The following actions are possible from the Elements grid:

Operation Resulting action

Click on an element
line, clip or log

Simply selects the element.

Double-click a clip
line

Loads the clip on the sourcemonitor of Premiere Pro CC.
Depending on the underlying clip type the behavior varies.
• If the IPDirector clip is the source clip then the source clip is

loaded on the sourcemonitor of Premiere Pro CC.
• If the IPDirector clip is a subclip that has been created from a

source clip then the source clip is loaded on the source
monitor of Premiere Pro CC with Mark IN andMark OUT
points set that represents the region referenced by the
IPDirector subclip.
The screenshot below illustrates an IPDirector subclip loaded
onto the sourcemonitor of Premiere Pro CC. This means that
as long as the source clips aremade available on the
IPDirector managed storage, then any IPDirector subclips
created from the source clips do not result in duplicated
media on storage.

Double-click a log
line

Loads the corresponding ‘Protect Media’ clip, as created from the
relevant recorder set as preview in IPDirector, in the source
monitor of Premiere Pro CC, at the log timecode point.
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4.4. Quick Text Search Area

4.4.1. Introduction
TheQuick Text Search is used to perform a search based on free text entered in the
Quick Text Search field. This field is available on the top of the Elements grid. You can
perform a search on displayed columns or a search on all columns (displayed and hidden
columns).

The search is performed on the selected tree branch or breadcrumb.

See section "Quick Text Search" on page 24 for details on the various ways to use this
function.

4.4.2. Quick Text Search Associated Buttons
The following table gives a description of the buttons located next to theQuick Text
Search field. These buttons may be used not only for the Quick Text Search function but
also for the other search functions in the grid.

Interface
Element Description

Applies the search again and refreshes the Elements grid.

Clears the applied Quick Text search.

4.5. Advanced Search Pane

4.5.1. Purpose
Advanced Search functions are available for detailed search operations. They allow
searches onmetadata of the element type selected from the Tree view. The Advanced
Search pane is located on the bottom left part of the IPLink for Adobe window.

See section "Advanced Search" on page 27 for details on the various ways to use this
function.
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4.5.2. Overview of the Advanced Search Pane

Illustration

The Advanced Search pane contains the areas highlighted on the screenshot below:

Area Description

The table below describes the various parts of the Advanced Search pane:

Area Description / See also…

1. Add Search
Criteria field

This field gives access to the list of criteria on which users may
perform a search. The lists differ according to the selected item type.
See section "Advanced Search Fields Display" on page 27.

2. Search
Parameters
area

This area displays the list of search parameters selected from the
Add Search Criteria field.
Different types of search parameters exist. See section "Advanced
Search Fields Types" on page 28.
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5. Searching for Media

5.1. Filtering Tools
When the IPDirector database contains large amounts of data, it may become difficult to
find a specific element. The IPLink window offers several ways to refine the list of
elements displayed in the Element grid and speed up your search:

• Branch selection in the Tree view - Select a branch in the Tree view to limit the list to
specific item types or only a subset of the Tree view.

• Quick text search - Enter free text in theQuick Text Search field to perform a search
on a specific string.

• Advanced search filter – Enter specific criteria in the Advanced Search pane to
perform a search on specific metadata associated with the elements.

All these search tools can be combined.

A search can also be facilitated by ordering the Elements grid. See section "Elements
Grid" on page 18 for more information.

5.2. Branch Selection in the Tree
The Tree view allows the users to browse between clips on IPDirector managed nearline
storage, clips or edits stored in IPDirector bins, edits or logs. By browsing the tree
structure, a selection is made and displayed in the Element grid. The breadcrumb provides
an indication of the tree path to the currently displayed item elements and allows users to
navigate back to the upper level.

See section "Tree View" on page 15 for a description of the user interface elements of the
Tree view.

5.3. Quick Text Search

5.3.1. Purpose and Context of Use
TheQuick Text Search function is used to perform a search based on free text entered in
theQuick Text Search field. This field is available on the top of the Elements grid:

See section "Quick Text Search Associated Buttons" on page 22 for the description of the
buttons associated to theQuick Text Search field.
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Users can enter a search string in one of the following ways.

• Entering the search string in full in theQuick Text Search field.

• Starting to type a search string in theQuick Text Search field, so the Autocomplete
function displays a list of proposals, and one of them can be selected. See section
"Autocomplete Function in Quick Text Search Field" on page 26.

5.3.2. Search on Displayed / All Columns

Search on Displayed Columns
To activate theSearch on Visible Columns option, proceed as follows:

1. Right-click a column header.

A menu is displayed.

2. Select Preferences.

The Preferences window opens.

3. From theGeneral tab, in theSearch Scope field, select Visible Columns.

Then, the columns that are taken into consideration for the Quick Text Search are the
ones currently visible in the Elements grid. You can add other columns to the Elements
grid view by right-clicking the grid header and selectingOrganize Columns from the
contextual menu.

Search on All Columns
To activate theSearch on All Columns option, proceed as follows:

1. Right-click a column header.

A menu is displayed.

2. Select Preferences.

The Preferences window opens.

3. From theGeneral tab, in theSearch Scope field, select All Columns.

Tip
If you perform a Search on all columns without having displayed all the columns,
you will not be able to identify in which column the search string has been found.
For the sake of clarity, it is recommended to display all columns when you
perform a Search on all columns.
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5.3.3. Quick Text Search Syntax Rules
The string that you enter in theQuick Text Search field is analyzed according to the
following set of rules:

Search
String Search Result Logical

Equivalent

Yellow card Searches for the words yellow and card, even if in
two different fields (columns), for example yellow in
Name and card in Keywords.
For example a clip named "The Yellow Man" with
keywords "Red Card" will be found, since it has
yellow and card in 2 different fields.

"Yellow" AND
"card"

Yellow | card Searches for yellow or card, even if in two different
fields (columns), for example yellow in Name or
card in Keywords.

"Yellow" OR
"card"

"Yellow card" Searches for exact matches of Yellow card. 
Between the quotes, all characters are considered
as characters and not operators or wildcards.

"Yellow card"

card* Searches for card at the beginning of a word.  "card"*

*card* Searches for all words that include card. *"card"*

=card Searches for a whole field that contains only card.
For example, if a field contains yellow card, the
=card condition will not return any result.

Search operators may be combined.

5.3.4. Autocomplete Function in Quick Text
Search Field

Introduction
The Autocomplete function is a help service for the capture of the search string.

As soon as the users start typing in theQuick Text Search field, the Autocomplete
function provides a list of matching words and sentences known by the system and
containing a word beginning with the typed letters.
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How to Perform a Quick Text Search with the
Autocomplete Function
To perform aQuick Text search, proceed as follows:

1. Select the tree branch you wish to perform a quick search on.

2. Select theSearch on All Columns option from the Preferences window or, if the
Search on Visible Columns option is selected, display the columns you wish to
perform a search on in the Elements grid.

3. Type a search string in theQuick Text Search field.

A list of proposals is displayed as soon as you start to type and it is refined as you go
on typing.

4. Select a line by using themouse or the key.

5. Press ENTER.

The search is launched with the selected proposal.

The search results are displayed in the grid.

6. To clear the applied Quick Text Search, click theClear Quick Text Search button

(white ) to the right of the search field.

5.4. Advanced Search

5.4.1. Purpose and Context of Use
The Advanced Search functions are available for more detailed search operations. They
allow searches on clips, edits or logs metadata.

The Advanced Search pane is located on the bottom left part of the IPLink window. Users
can choose the advanced search parameters they want to display.

5.4.2. Advanced Search Fields Display

Displaying Advanced Search Fields

The list of available advanced search parameters is available by clicking the arrow next to
theAdd Criteria field.

USER MANUAL IPLink for Adobe 1.3 Plugin

5. Searching for Media 27



Depending on themedia type (edits, clips or logs) selected in the Tree view, different lists
of advanced search parameters are proposed.

To display an advanced search parameter, select one of the options from theAdd
Criteriamenu. The selected parameter is displayed in the Advanced Search pane.

Parameters of which values are in the form of an option list have a filter applied as soon as
they are selected. For example, in the case of Color, or Level,...

Hiding Advanced Search Fields

To remove an advanced search field from the Advanced Search pane, click the cross in
the upper right corner of the criterion box. Applied filters are cleared as soon as a search
field is removed.

5.4.3. Advanced Search Fields Types
Different types of advanced search fields exist:

• free text fields: search data can be entered directly in these fields, e.g. Name field.
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• field with an option list: an arrow giving access to a list of options is available on the
right of the field or a list of options is displayed in the area for direct selection, e.g.
Level field.

5.4.4. Search in Free Text Fields

Autocomplete Function in Free Text Search Fields
The Autocomplete function is a help service for the capture of the search string. The
Autocomplete function, described in section "Autocomplete Function in Quick Text
Search Field" on page 26 for the Quick Text Search, is also enabled during searches in
free text search fields of the Advanced Search pane.

Preliminary Steps
1. Select the tree branch in the Tree view.

2. Select theSearch on All Columns option from the Preferences window or, if the
Search on Visible Columns option is selected, display the columns you wish to
perform a search on in the Elements grid.

3. In the Advanced Search pane, display the search criterion.

How to Perform a Search on Free Text
To enter search values in a free text field of the Advanced Search pane, proceed as
follows:

1. Type a search string in the field.

A list of proposals is displayed as soon as you start to type and it is refined as you go
on typing.

2. Select a line by using themouse or by pressing the key.

3. Press ENTER.

The search is launched on the selected tree branch.

The search results are displayed in the grid.
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5.4.5. Search in Non-Free Text Fields

Preliminary Steps
Non-free text search fields of the Advanced Search pane give access to an option list to
select a search value.

Before starting a search, do the following steps:

1. Select the tree branch in the Tree view.

2. Select theSearch on All Columns option from the Preferences window or, if the
Search on Visible Columns option is selected, display the columns you wish to
perform a search on in the Elements grid.

3. In the Advanced Search pane, display the search criterion.

How to Perform a Search based on an Option List
To set a search criterion from an option list, proceed in one of the following ways:

When the options are displayed in the area, e.g. Level field:

• Click the appropriate button:

When the options are displayed in a list:

1. Click the arrow next to a search field to display the option list for the corresponding
criterion

2. Select the appropriate value.
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6. Importing Media into Premiere
Pro

6.1. Importing Media into a Project

How to Import Clips into a Project

Introduction

One or several clips can be imported into a Premiere Pro project.

This can be done in one of the ways described hereafter.

When using either Method 1 or Method 2 to import clips, the imported clips are
represented in Premiere Pro CC in different ways according as the clip to import is a
source clip or subclip.

If the clip is a source clip in IPDirector, it is imported into the Premiere Pro CC project as a
masterclip.

If the clip is a subclip in IPDirector, created from a source clip, then it is imported into
Premiere Pro CC as a subclip.

Method 1
1. Select one or several clips from the Elements grid.

2. Click the Import button.

The clips are referenced in the Premiere Pro project.

Method 2
1. Select one or several clips from the Elements grid.

2. Drag the clips onto the project opened in Premiere Pro.

The clips are referenced in the selected Premiere Pro project.
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Method 3
1. Double click a clip from the Elements grid.

This loads the correspondingmedia file in the Premiere Pro CC sourcemonitor panel.

2. Directly edit a marked segment from the Premiere Pro CC sourcemonitor panel into a
sequence timeline.

The correspondingmedia file is automatically added to the Premiere Pro CC project.

How to Import Logs into a Project

Introduction

One or several logs can be imported into a Premiere Pro project. Actually, logs are not
imported as such. The import applies to the Protect Media clips associated to the selected
logs, and created from the relevant recorder set as preview in IPDirector.

This can be done in one of the following ways.

Method 1
1. Select one or several logs from the Elements grid.

2. Click the Import button.

Method 2
1. Select one or several logs from the Elements grid.

2. Drag the logs onto the project opened in Premiere Pro.

The IPDirector Protect Media clips associated to the selected logs, and created from the
relevant recorder configured as preview in IPDirector, are referenced in the selected
Premiere Pro project.

Method 3
1. Select a log and double click to load the correspondingmedia file in the Premiere Pro

CC sourcemonitor window.

2. Preview the log and directly edit a marked segment from the Premiere Pro CC source
monitor panel to a sequence timeline.

The correspondingmedia file is imported into the Premiere Pro CC project.

Log Associated with Multiple Camera Angles
If there aremultiple camera angles associated with a log, then the IPLink plugin window
can be used to select and preview the individual angles before using them in an edit or
importing them to the Premiere Pro project.
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When logs are viewed, the IPLink plugin window displays a set of Angle buttons which
can be used to pre-select the angle that will be loaded into the Premiere Pro source
monitor when the log is double-clicked.

Only those angles that are available for a log can be pre-selected.

To view the alternative angle for a loaded log, select a different Angle button and then
double click the log item. The alternative angle is loaded into the Premiere Pro source
monitor.

When importing logs that havemultiple angles associated with them (using the Import
button in the IPLink window), the clips corresponding to each angle will be imported to the
Premiere Pro project.

For more details of the Logs import behaviour for specific Premiere Pro versions see
IPLink for Adobe Release Notes.

How to Create a Sequence from an Edit

Introduction

One or several edits can be imported into a Premiere Pro project.

This can be done in one of the ways described hereafter.

Only empty placeholder edits can be imported into Premiere Pro.

The Premiere Pro CC sequence settings to be applied when importing an IPDirector edit
can be configured using theSequence Template for Edit Imports parameter from the
Preferences > General tab.

Method 1
1. Select one or several edits from the Elements grid.

2. Click the Import button.

The edit is imported and referenced in the current Premiere Pro project.

Method 2
• Double-click the edit that is to be imported.

The edit is imported and referenced in the current Premiere Pro CC project.
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6.2. Importing Media into a Sequence
A clip cannot be directly dragged from the IPLink panel and dropped onto the Premiere Pro
CC sequence timeline.

Either load the clip into the sourcemonitor and then edit themarked region of the clip to
the timeline (using edit buttons or drag and drop operation) or import the clip(s) to the
Premiere Pro CC project panel and the clip(s) can then be dragged and dropped from there
to the sequence timeline.
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